
 AN4528
 Libero® SoC PolarFire® Design Flow

Introduction
This application note describes how to implement the basic PolarFire® Field Programmable Gate Array (FPGA)
designs using the Libero® System-on-Chip (SoC) PolarFire design tool. Each section introduces new features on top
of the previous section. After completing this demo, you will be familiar with the following steps.

• 1.1.  Step 1—Creating a Libero SoC PolarFire Project
• 1.2.  Step 2—Creating Your Design
• 1.3.  Step 3—Creating HDL
• 1.4.  Step 4—Creating SmartDesign
• 1.5.  HDL Testbench
• 1.6.  SmartDesign Testbench
• 1.7.  Step 5—Synthesis and Pin Assignment
• 1.8.  Step 6—Programming the Device
• 1.9.  Step 7—Running the Design
• 1.10.  Step 8—Design Iterations in the Libero SoC PolarFire

Prerequisites
The following table lists the prerequisites for the demo.

Table 1. Prerequisites for the Demo

System Requirements Description

Software requirements Libero SoC PolarFire v2021.2

Hardware requirements PolarFire Evaluation Kit (MPF300-EVAL-KIT)

Source files Not required. The design is created from scratch
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1. Running the demo
The following sections describe the step-by-step procedure to run this demo. See the Libero® SoC Design Flow User
Guide for detailed description of each step of Libero design flow.

1.1 Step 1—Creating a Libero SoC PolarFire Project
To create a Libero SoC project, perform the following steps.

1. Click Start > Programs > Microsemi Libero SoC PolarFire v2021.2 > Libero SoC PolarFire v2021.2, or
click the shortcut on your desktop. The following figure shows the Libero SoC PolarFire Project Manager
window.
Figure 1-1. Libero SoC PolarFire Project Manager

2. To create a new project, on the Start Page tab, click New (shown in the preceding figure), from the Libero Soc
menu, click Project > New Project . The New Project window is displayed.
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Figure 1-2. New Project Window

3. In the Project Details page of the New Project dialog box, enter the following information and then click 
Next.

– Project name: PolarFire_basic

– Project location:

<C: or D:>/Microsemiprj

(or the path to where the files are extracted).
– Preferred HDL type: Select either VHDL or Verilog based on the HDL preferences.

Note:  Project name is case sensitive for Verilog design.

Figure 1-3. Project Details
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4. In the Device Selection page of the New Project dialog box, enter the following details, and then click Next.
– Family: PolarFire
– Die: MPF300TS
– Package: FCG1152
– Speed: –1
– Range: IND

Figure 1-4. Device Selection

5. In the Device settings page of the New Project dialog box, enter the following details, and then click Finish.
– Core Voltage: 1.0 (default)
– I/O settings

• Default I/O technology: LVCMOS 1.8V
• Reserve pins for probes: Checked (default)

– System controller suspended mode: Un-checked (default)
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Figure 1-5. Device Settings

6. This is the page where you can add the existing HDL design source files to your Libero SoC project. The HDL
source files can be imported or linked to the Libero SoC project.
Figure 1-6. HDL Import

7. In this page, you can add the timing constraints and physical constraints files to the Libero SoC project by
importing or linking.
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Figure 1-7. Constraints Import

1.2 Step 2—Creating Your Design
To create a design, perform the following step.

The Design Flow window is used to manage design creation flow. This window has multiple tabs. You can switch
between these tabs by clicking the tabs at the bottom, as shown in the following figure.

Figure 1-8. Design Creation

1.3 Step 3—Creating HDL
To create a design in HDL, perform the following steps.

1. Double click Create HDL in the Design Flow window . The Create a new HDL file dialog box is displayed.
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Figure 1-9. Creating HDL

2. Under HDL Type section, select an option as shown in the previous figure. Select whether to Initialize file
with standard template to populate the file with default headers and footers.

3. Enter a name and click OK.
Note:  Do not enter a file extension because Libero SoC adds one for you, which is by default.

4. Click Save.

1.4 Step 4—Creating SmartDesign
To create a design in SmartDesign, perform the following steps.

1. In the Design Flow window, double click Create SmartDesign and name your design as andgate, and then
click OK. The SmartDesign Canvas is displayed.
Figure 1-10. Creating New SmartDesign

2. In the Design Flow window, click the Catalog tab, in the Design Flow window and then expand the Macro
Library section, as shown in the following figure.
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Figure 1-11. Catalog Tab

3. From the Catalog, drag AND2 gate onto the blank SmartDesign Canvas on the right.
4. Select A and then right click to bring up the menu. From the menu, select Promote to Top Level, as shown

in the following figure. This creates an external connection on the device that is connected to a switch. Repeat
the same steps for B and Y.
Figure 1-12. AND2 Gate

5. When you have completed this step, you should have the view shown in the following figure.

 AN4528
Running the demo

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004528A-page 9



Figure 1-13. AND2 Connection

6. Click the Generate Component button on the top of the canvas to generate the design.
The andgate was successfully generated message is displayed in the Libero SoC Log tab, as shown in the
following figure.

Figure 1-14. Successful Message in Libero SoC Log Tab

7. Select the Design Hierarchy window, set andgate as root, and then click Build Hierarchy as shown in the
following figure.
Figure 1-15. Design Hierarchy

andgate is displayed in the bold font under the Design Hierarchy tab, indicating that it is the root level.

1.5 HDL Testbench
To create HDL Testbench, perform the following steps.

1. In the Design Hierarchy, right click SmartDesign, and then select Create Testbench > HDL. Provide a name
for the testbench. The HDL testbench instantiates the selected SmartDesign into the component automatically.
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Figure 1-16. HDL Testbench

2. To create a new testbench file, under Create Design, double click Create HDL Testbench to display the
Create New HDL Testbench dialog box. The dialog box allows you to create a new testbench file, with the
option to include standard testbench content and your design data.
Figure 1-17. Creating New HDL Testbench File
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Figure 1-18. HDL Testbench File

3. To perform pre-synthesis simulation, go to Stimulus Hierarchy. Right click testbench and run Simulate
Pre-synthesis Design. For more information, see section 4.10 in Libero® SoC Design Flow User Guide for
the all families.
Figure 1-19. Pre-Synthesis SIM
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1.6 SmartDesign Testbench
SmartDesign Testbench component can be used as both top-level and lower-level testbench component.

1. In the Design Flow window, double click Create SmartDesign Testbench. The Create New SmartDesign
Testbench dialog box is displayed.
Figure 1-20. SmartDesign Testbench

2. Enter a unique component name.
3. Select Set as Active Stimulus to make this SmartDesign Testbench your active stimulus.
4. Click OK. The component is displayed under the Stimulus Hierarchy tab of the Design Explorer.
5. To perform simulation, need to add pulse generator. Go to Catalog tab, then select the Simulation option and

double click pulse generator under Clock & Management section.
Figure 1-21. Creating Pulse Generator Component

6. In Pulse Generator configurator, set the parameters in such way that all the input combinations are generated.
Repeat 5 and 6 steps to create another pulse generator.
Figure 1-22. Configuring Pulse Generator
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Figure 1-23. SmartDesign Testbench Canvas

To perform pre-synthesis simulation, go to Stimulus Hierarchy, double click Build Hierarchy, save and then
right click SmartDesign testbench and run Simulate Pre-synthesis Design.
Figure 1-24. Adding Simulation
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Figure 1-25. SmartDesign Pre-Synthesis SIM

1.7 Step 5—Synthesis and Pin Assignment
To perform synthesis and assign pin, perform the following steps.

1. In the Design Flow window, under Implement Design, double click Synthesize , as shown in the following
figure, to synthesize the design with Synplify Pro. Synplify Pro adds I/O pads to the design. A green check
mark appears in the Design Flow window to indicate synthesis was successful.
Figure 1-26. Synthesize in Design Flow

2. In the Design Flow window, double click Manage Constraints to open the Libero SoC Constraints
Manager.
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Figure 1-27. Libero SoC Constraints Manager

3. Confirm that the I/O Attributes tab is selected. From the list on the Edit button, select Edit with I/O Editor
(highlighted in the preceding figure) to open the I/O Editor.

4. Select the Port View tab of the I/O Editor, as shown in the following figure.
Figure 1-28. I/O Editor

5. Use this window to set the I/O Standard and Pin Number. Confirm that LVCMOS18 is the I/O standard for
each pin, as shown in the following figure.

6. In the Pin Number column, click Unassigned to reveal available I/O pins. Make the following assignments.
You can either type the pin number in the field or use the list to select the pin.

– A—B19
– B—C21
– Y—C26
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7. Ensure the connections match the following screenshot, then select File > Commit, and close the window by
clicking File > Exit.
Figure 1-29. I/O Standard and Pin Number Assignments

8. To add timing constraints (if required for your design), see Timing Constraints Editor User Guide for Libero
SoC v2021.2 for all the families.
Push-Button Switches

The PolarFire evaluation board comes with four debug push button switches connected to the PolarFire
FPGA. The following table lists the on-board push button switches.

Table 1-1. PolarFire Evaluation Kit - Push-Button Switches

PolarFire® Evaluation Board Pin PolarFire FPGA
Pin Number

PolarFire FPGA Pin Name Bank

SW10 B19 HSIO46PB6 Bank - 6

SW9 C21 HSIO49PB6 Bank - 6

SW8 A25 HSIO68PB6/DQS/CCC_SE_PLL1_OUT0 Bank - 6

SW7 B27 HSIO69NB6 Bank - 6

The following figure shows push button and pin connections.
Figure 1-30. Push-Button and Pin Connections
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User LEDs

The board provides user access to eight active-high LEDs that are connected to the PolarFire device for
debugging applications. The following table lists the on-board user LEDs.

 AN4528
Running the demo

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004528A-page 17

https://www.microsemi.com/document-portal/doc_download/1245842-timing-constraints-editor-user-guide-for-libero-soc-v2021-2-for-all-the-families
https://www.microsemi.com/document-portal/doc_download/1245842-timing-constraints-editor-user-guide-for-libero-soc-v2021-2-for-all-the-families


Table 1-2. PolarFire Evaluation Kit - User LEDs

PolarFire® Evaluation Board Pin PolarFire
FPGA Pin
Number

Number PolarFire Pin Name Bank

LED7 D25 HSIO70PB6/CCC_SE_PLL1_OUT1 Bank - 6

LED6 C26 HSIO70NB6 Bank - 6

LED5 B26 HSIO71NB6 Bank - 6

LED4 F22 HSIO64NB6 Bank - 6

LED11 H21 HSIO36NB6 Bank - 6

LED10 H22 HSIO60NB6 Bank - 6

LED9 F23 HSIO62PB6/DQS/CCC_SE_PLL0_OUT0 Bank - 6

LED8 C27 HSIO71PB6/CCC_SE_CLKIN_S_15 Bank - 6

The following figure shows how the LEDs are connected to the PolarFIre FPGA. When the PolarFire output
goes high (logic 1), the LED turns on. When the output goes low (logic 0), the LED turns off.

Figure 1-31. PolarFire Evaluation Kit User Defined LEDs

PolarFire
NPN 

Transistor
499 Ω

3.3 V

Note:  For more information, see the PolarFire Evaluation Board Schematic document provided separately.
9. To perform place and route, under Implement Design in the Design Flow window, double click Place and

Route .

 AN4528
Running the demo

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004528A-page 18

https://www.microsemi.com/document-portal/doc_download/136590-polarfire-evaluation-kit-schematics


Figure 1-32. Place and Route

Note:  Double click Verify Timing to perform timing analysis for sequential circuits and to analyze the
generated timing report. If there are any timing violations in design, then see SmartTime Static Timing Analysis
(STA) for Libero SoC v2021.2 for all the families.
Figure 1-33. Programming Design Flow Image

Generate FPGA Array Data

Generate FPGA Array Data tool generates database files used in the following downstream tools:

– *.map files used for programming
– RAM structural information used in Configure Design Initialization and Memories tools

To generate FPGA array data, double click Generate FPGA Array Data. Ensure to complete Place and
route step.
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Generate Design Initialization Data

This tool is used to generate initialization data of the design, if there are any initialization clients of Fabric
RAMs.

Generate Bitstream

This tool incorporates the fabric design, sNVM configuration, eNVM configuration (if configured), and custom
security settings (if configured) to generate the bit stream file. Before you generate the bit stream, configure
the bit stream. Otherwise, default settings with all available features included are used. To display the
Configure Bit stream dialog box, expand Program Design, right click Generate Bitstream, and then select
Configure Options to select the components you want to program.

1.8 Step 6—Programming the Device
The following steps describe how to run the FlashPro in batch mode to program the PolarFire MPG300 on the
PolarFire evaluation board, as shown in the following figure.

Figure 1-34. PolarFire Evaluation Kit Board

1. Prior to programming (and powering up) the PolarFire evaluation board, confirm that the jumpers are
positioned as listed in the following table.

Table 1-3. Jumper Settings

Jumper Description Pin Default Setting

J18, J19, J20,
J21, J22

Jumpers to select
the PolarFire
JTAG or A2F
JTAG

Close pin 1 and 2 for programming the power sequence
and monitoring chip through the FTDI.
Close pin 2 and 3 for programming the PolarFire® FPGA
through FTDI.

You must always retain the default jumper setting.

Open
Closed
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...........continued
Jumper Description Pin Default Setting

J46 Jumper to select
switch-side MUX
inputs of A or B to
the line side

Close pin 1 and 2 (Input A to the line side) for routing the
on-board 122.88 MHz differential clock oscillator output
to the line side.
Close pin 1 and 2 (Input B to the line side) for routing
the on-board 125 MHz differential clock oscillator output
to the line side.

Open
Closed

J28 Jumper to select
the external JTAG
or the onboard
FlashPro5 for
programming the
PolarFire device

Close pin 1 and 2 for programming through the on-board
FlashPro5.

Closed

J26 Jumper to select
the FTDI SPI or
SC_SPI header

Close pin 1 and 2 for programming through the SC_SPI
Header.

Open

J27 Jumper to select
between FTDI SPI
or External SPI
Flash to program
the device

Close pin 1 and 2 for programming through the External
SPI Flash.

Open

J23 Jumper to define
the SPI interface
mode

Close pin 1 and 2 to define the SPI Slave mode. Open

J4 Jumper to select
the SW3 input or
the ENABLE_FT4
232 signal from
the FT4232H chip

Close pin 1 and 2 for manual power switching using
SW3.
Close pin 2 and 3 for remote power switching using the
GPIO capability of the FT4232 chip.

Closed
Open

J12 Jumper to select
the PolarFire
VCCIO voltage
(VCCIO_HPC_VA
DJ) to 1.2V, 1.5V,
1.8V, 2.5V, or
3.3V

Close pin 1 and 2 for 3.3V.
Close pin 3 and 4 for 2.5V.

Close pin 5 and 6 for 1.8V.

Close pin 7 and 8 for 1.5V.

Close pin 9 and 10 for 1.2V.

Open
Closed

Open

Open

Open

J43 Jumper to select
the VDD voltage

Close pin 1 and 2 for 1.05V Open

2. Connect 12V power supply brick to the J2 connector.
3. Connect a USB cable between the J1 mini USB connector and the host PC.
4. Slide the main power switch SW1 to ON.
5. Install the FlashPro4 drivers if prompted. The drivers are located in the

<Libero SoC PolarFire v2021.2 Installation Directory>\drivers

folder.
6. To program the design, a programmer must be selected. For that, expand the Configure Hardware, double-

click Select Programmer. From the list, select the programmer you want to use. If no programmers
are connected, connect a programmer without closing the dialog box, and then click Refresh/Rescan
Programmers to display the connected programmer from the list.
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Figure 1-35. Select Programmer Dialog Box

7. In the Design Flow window, expand Program Design. Right click Run PROGRAM Action and select Run to
generate the programming file and begin programming.
Figure 1-36. Run Program Action

8. FlashPro runs in batch mode and programs the device. Programming messages are visible in the Libero SoC
log window (programmer number differs).
Note:  Do not interrupt the programming sequence.

9. The following message is displayed in the Reports view under Run PROGRAM Action, when the device is
programmed successfully (programmer number differs).
programmer 'E2001JZK2X': device 'MPF300T_ES': Executing action PROGRAM PASSED.
programmer 'E2004OQL7D': device 'MPF300TS': Executing action PROGRAM PASSED.
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Figure 1-37. Reports Tab

A green tick mark appears next to Program Design and Run PROGRAM Action in the Design Flow window
to indicate successful programming as shown in the following figure.
Figure 1-38. Design Flow Green Tick Marks

10. To save your completed project, from the Libero menu, click Project > Save.
Note:  Do not close the window.

To debug your design in real time, use SmartDebug tool. For more information about SmartDebug tool, see
SmartDesign v2021.2 User Guide for all the families.
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1.9 Step 7—Running the Design
This is a very simple design designed to show an AND gate. The following steps are performed to run the design.

1. Observe LED1 with switch 5 and switch 6 released—it illuminates.
2. Press switch 5 and observe the behavior of LED1—it turns OFF.
3. Press switch 6 and observe the behavior of LED1—it turns OFF.
4. Press both switches to turn OFF LED1.

For an AND gate, you might expect the LED to illuminate when both switches are pressed, but in this application,
releasing the switch generates a logic one, which illuminates the LED. To correct this, you must invert the inputs to
the AND gate. For more information, see Figure 16 Switches Interface in UG0747: PolarFire FPGA Evaluation Kit
User Guide.

1.10 Step 8—Design Iterations in the Libero SoC PolarFire
To design iteration in the Libero SoC PolarFire v2021.2, perform the following steps.

1. Reopen the SmartDesign Canvas again, look for the andgate tab.
2. Hold the Ctrl key and select input ports A and B of AND2_0, then right click to bring up the menu. Select

Invert to invert the signals, as shown in the following figure. This is built into the SmartDesign capabilities to
invert or tie off any I/O.
Figure 1-39. Design Iterations

The ports are inverted.

Figure 1-40. Ports Inversion

3. Generate the Component . It resets the rest of the compilation functions, but keeps your I/O constraints.
4. In the Design flow window, right click Run PROGRAM Action , then select Update and Run to run all the

steps in between and reprogram the device in one click.
5. Check if the Warning dialog box about running in non-timing-driven mode is displayed behind your active

window.
6. Observe the correct behavior on the board by pressing both switches simultaneously to illuminate LED1.

This step completes the tutorial of the Libero SoC PolarFire v2021.2 design flow.
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2. References
The following documents are referred for this demo.

• UG0758: PolarFire FPGA Design Flow User Guide
• UG0779: SmartDesign User Guide for PolarFire
• UG0750: PolarFire FPGA I/O Editor User Guide
• PolarFire FPGA Tcl Commands Reference Guide
• UG0776: PolarFire FPGA Design Constraints User Guide
• UG0769: Timing Constraints Editor User Guide for PolarFire
• UG0738: Netlist Viewer Interface User Guide for PolarFire
• UG0821: PolarFire FPGA Chip Planner User Guide
• SmartPower User Guide for Libero SoC PolarFire
• UG0773: PolarFire FPGA SmartDebug User Guide

 AN4528
References

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004528A-page 25

http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=136916
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20137629
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136917
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136920
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136921
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136922
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136923
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136580
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136574
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=%20136919


3. Revision History
The revision history describes the changes that were implemented in the document. The changes are listed by
revision, starting with the most current publication.

Revision Date Description

A 04/2022 The following is the list of changes in revision A of the document:

• The document was migrated to the Microchip template.
• The document number was updated to DS00004528A from

50200844.

3.0 — The following is a summary of the changes in revision 3.0 of this
document.

• Updated the document for Libero SoC v2021.2.
• Updated section 1.1.  Step 1—Creating a Libero SoC

PolarFire Project
• Updated section 1.2.  Step 2—Creating Your Design
• Added section 1.3.  Step 3—Creating HDL
• Added section 1.4.  Step 4—Creating SmartDesign
• Added section 1.5.  HDL Testbench
• Added section 1.6.  SmartDesign Testbench
• Updated section 1.7.  Step 5—Synthesis and Pin

Assignment
• Updated section 1.8.  Step 6—Programming the Device

2.0 — The following is a summary of the changes in revision 2.0 of this
document.

• Updated section 1.1.  Step 1—Creating a Libero SoC
PolarFire Project

• Updated section 1.7.  Step 5—Synthesis and Pin
Assignment

1.0 09/2018 Initial Revision.
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Microchip FPGA Support
Microchip FPGA products group backs its products with various support services, including Customer Service,
Customer Technical Support Center, a website, and worldwide sales offices. Customers are suggested to visit
Microchip online resources prior to contacting support as it is very likely that their queries have been already
answered.

Contact Technical Support Center through the website at www.microchip.com/support. Mention the FPGA Device
Part number, select appropriate case category, and upload design files while creating a technical support case.

Contact Customer Service for non-technical product support, such as product pricing, product upgrades, update
information, order status, and authorization.

• From North America, call 800.262.1060
• From the rest of the world, call 650.318.4460
• Fax, from anywhere in the world, 650.318.8044

The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
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• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code
protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer, LANCheck,
LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST, MOST logo, MPLAB,
OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer, QTouch, SAM-BA, SenGenuity,
SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon, TimeSource, tinyAVR, UNI/O, Vectron,
and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper Speed
Control, HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC
Plus, ProASIC Plus logo, Quiet- Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra,
TimeProvider, TrueTime, WinPath, and ZL are registered trademarks of Microchip Technology Incorporated in the
U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, GridTime,
IdealBridge, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, Inter-Chip Connectivity,
JitterBlocker, Knob-on-Display, maxCrypto, maxView, memBrain, Mindi, MiWi, MPASM, MPF, MPLAB Certified
logo, MPLIB, MPLINK, MultiTRAK, NetDetach, NVM Express, NVMe, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-
ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher,
SuperSwitcher II, Switchtec, SynchroPHY, Total Endurance, TSHARC, USBCheck, VariSense, VectorBlox, VeriPHY,
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ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip Technology Incorporated in the
U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, Symmcom, and Trusted Time are registered
trademarks of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2022, Microchip Technology Incorporated and its subsidiaries. All Rights Reserved.

ISBN: 978-1-6683-0283-5

Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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AMERICAS ASIA/PACIFIC ASIA/PACIFIC EUROPE
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support:
www.microchip.com/support
Web Address:
www.microchip.com
Atlanta
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455
Austin, TX
Tel: 512-257-3370
Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago
Itasca, IL
Tel: 630-285-0071
Fax: 630-285-0075
Dallas
Addison, TX
Tel: 972-818-7423
Fax: 972-818-2924
Detroit
Novi, MI
Tel: 248-848-4000
Houston, TX
Tel: 281-894-5983
Indianapolis
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380
Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800
Raleigh, NC
Tel: 919-844-7510
New York, NY
Tel: 631-435-6000
San Jose, CA
Tel: 408-735-9110
Tel: 408-436-4270
Canada - Toronto
Tel: 905-695-1980
Fax: 905-695-2078

Australia - Sydney
Tel: 61-2-9868-6733
China - Beijing
Tel: 86-10-8569-7000
China - Chengdu
Tel: 86-28-8665-5511
China - Chongqing
Tel: 86-23-8980-9588
China - Dongguan
Tel: 86-769-8702-9880
China - Guangzhou
Tel: 86-20-8755-8029
China - Hangzhou
Tel: 86-571-8792-8115
China - Hong Kong SAR
Tel: 852-2943-5100
China - Nanjing
Tel: 86-25-8473-2460
China - Qingdao
Tel: 86-532-8502-7355
China - Shanghai
Tel: 86-21-3326-8000
China - Shenyang
Tel: 86-24-2334-2829
China - Shenzhen
Tel: 86-755-8864-2200
China - Suzhou
Tel: 86-186-6233-1526
China - Wuhan
Tel: 86-27-5980-5300
China - Xian
Tel: 86-29-8833-7252
China - Xiamen
Tel: 86-592-2388138
China - Zhuhai
Tel: 86-756-3210040

India - Bangalore
Tel: 91-80-3090-4444
India - New Delhi
Tel: 91-11-4160-8631
India - Pune
Tel: 91-20-4121-0141
Japan - Osaka
Tel: 81-6-6152-7160
Japan - Tokyo
Tel: 81-3-6880- 3770
Korea - Daegu
Tel: 82-53-744-4301
Korea - Seoul
Tel: 82-2-554-7200
Malaysia - Kuala Lumpur
Tel: 60-3-7651-7906
Malaysia - Penang
Tel: 60-4-227-8870
Philippines - Manila
Tel: 63-2-634-9065
Singapore
Tel: 65-6334-8870
Taiwan - Hsin Chu
Tel: 886-3-577-8366
Taiwan - Kaohsiung
Tel: 886-7-213-7830
Taiwan - Taipei
Tel: 886-2-2508-8600
Thailand - Bangkok
Tel: 66-2-694-1351
Vietnam - Ho Chi Minh
Tel: 84-28-5448-2100

Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4485-5910
Fax: 45-4485-2829
Finland - Espoo
Tel: 358-9-4520-820
France - Paris
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Garching
Tel: 49-8931-9700
Germany - Haan
Tel: 49-2129-3766400
Germany - Heilbronn
Tel: 49-7131-72400
Germany - Karlsruhe
Tel: 49-721-625370
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Germany - Rosenheim
Tel: 49-8031-354-560
Israel - Ra’anana
Tel: 972-9-744-7705
Italy - Milan
Tel: 39-0331-742611
Fax: 39-0331-466781
Italy - Padova
Tel: 39-049-7625286
Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Norway - Trondheim
Tel: 47-72884388
Poland - Warsaw
Tel: 48-22-3325737
Romania - Bucharest
Tel: 40-21-407-87-50
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
Sweden - Gothenberg
Tel: 46-31-704-60-40
Sweden - Stockholm
Tel: 46-8-5090-4654
UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820
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